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Contact Support 

For your convenience, Eaton provides one site where you can access the information that you need for 

our DCIM products. You can access the resources listed below by going to 

https://eatonexperience.force.com/login.  
 

• Online and telephone contact information for technical assistance and customer services 

• Product and documentation downloads 

• Other helpful resources appropriate for your product 

https://eatonexperience.force.com/login.
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1. Introduction 

1.1. 3D Application Overview 

The 3D Client User Guide provides detailed instructions for implementing and maintaining the 

application. 

The 3D application portal lets you access a wide array of data information from several disparate sources 

in one consolidated interface. The power of this aggregation is the simplicity it provides to operators to 

monitor and control both Facilities and IT devices in the data center environment. Since the application is 

vendor neutral, any device can be included in the interface and monitoring capabilities. 

The 3D application provides the following features for data center operators: 

• 3D Visual Navigation and Information to multiple floor plans 

• Navigation to Main Data Center floor plans or Remote IT closets 

• Real-time data metrics related to any device in the system 

• Historical trend analysis for metrics defined for devices 

• Integrated File Depot for document aggregation and management. This feature provides a single 

location for all data center related As Built drawings, Vendor Contract, Support Agreements, 

Photos, Policies and Procedures related to your environment. 

• Administrators can assign new devices to floor plans and customize the images and menu links 

associated with them. 

• Full featured Rack Builder. This feature permits administrators to create online graphical 

representations of their rack layouts. Key information related to devices and racks can then be 

viewed individually or at the rack level to understand the Weight, Power and physical 

characteristics of that rack. 
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2. Client versus Web 

The application provides two interfaces for the user to access with each providing some different 

functions. In many cases the features overlap. The 3D client provides the 3D display of the floors and 

devices. 

• Location Studio – Build and configure the navigation tree for all locations managed by the 

application. Create floor plans for assigning devices. 3D Client links to Web Interface. 

• Device placement – Assign, remove and relocate devices on floor plans. Available in both 

3D Client and Web Interface. 

• Device Data Viewing – View all data related to a device including alarms, graphs, trend 

charts, service events, port mappings, file depot and more. Available in both 3D Client and 

Web Interface. 

• Alarms – View all alarm information for locations and devices. Available in both 3D Client 

and Web Interface. 

• Site Summary Data – View summary data related to sites for energy consumption and 

energy costs based on device performance of devices at that location. 

• Port Mapping – Define network and power relationships between devices. 3D Client links 

to Web Interface. 

• Project Wizard – Create work order-based device actions and assign tasks to users of the 

application. 3D Client links to Web Interface. 

• Network and Power Paths – Create one-line summary of the network, a power tree of a 

facility, or both. This feature allows logical and physical definitions. 

• Capacity Planner – Analyze key capacity metrics related to locations and devices. This tool 

allows for what if comparisons of actual and modeled device scenarios. 3D Client links to 

Web Interface. 

• Root Cause | Impact Analysis – Analyzes the port connections to determine impacts and 

dependencies for devices connected on the power and network paths. 3D Client links to 

Web Interface. 

• Data Control – Manual change of data values or scheduled calendar changes to be 

automatically changed based on a user defined calendar for changes. 

• Reports – View all reports related to device performance and application information. 3D 

Client links to Web Interface. 

• Services – View and manage calendar events and warranty data for all devices in the 

system. 3D Client links to Web Interface. 
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3. 3D Client Interface 

3.1. How to Access the Client Interface 

The application client package is installed on the client computer system. The package provides 

application files to use for accessing an instance. The following are three ways to access the client 

interface from a computer on which the application is installed: 

• Start Menu – Lets you run the program from the Start Menu. 

• Desktop Icon – Lets you run the 3D client by double-clicking this icon. During the client installation 

process, a desktop icon is added to the user’s desktop. 

• File Manger – Lets you run the .exe file, which is installed to the following location by default (the 

final folder will have a version number of the installation package). Note that installers can install 

this package to a different folder during the installation process. 

3.2. Login to the Client Application 

The login credentials for the 3D Client are the same as those defined for the web interface. 

• Username/Password - use the same combination as used for the web interface. 

• Language - select from supported languages 

• Open Maximized checkbox - when checked the application will open full screen 

• Remember my settings checkbox - when checked the username is retained 
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3.3. Login Profiles 

The application lets you create multiple access profiles. This feature lets you access multiple instances 

from your client by using a single version of the client software. If one or more of the instances are of 

different versions, you will need to have a different client for each. All clients will access the same 

Settings file, so maintenance of separate Settings files is not needed. 

When the client installation is complete, you are prompted to create the default access profile. The 

profile consists of the URL used to access the interface in the web browser. If new profiles need to be 

added to the client, you can create them by accessing the Settings application from the Windows 

Program menu. 

When this program is opened, you can click the New button to define a new profile for the client. Enter 

the URL to be used to access the new instance. The new profile is added to the profile list. Note that 

these settings are saved to the following windows file: 

c:\users\[your windows logon name]\appdata\local\VDC\VDC.exe.config 

If multiple profiles exist on the client, you can select the profile that you want to use to connect when 

you open the application. If the client can establish a connection to the selected server instance, the 

logon page appears to let you connect to the system. 

3.4. Login to Incorrect URL Error Message 

When user's login with the incorrect URL, an error message window will indicate that the URL is not 

correct, and the correct URL is provided. 

Incorrect URLs include: 

• Any URL other than the one designated during installation 

• The IP address 

• A URL that resolves to the IP address but was not the URL designated during installation 

3.5. Running the Client in a Citrix Environment 

In a Citrix environment the user does not have a personal folder to retain the 3D client settings. This can 

be resolved by adding login information to the application string in the desktop shortcut. You will need 

the following information: 

• URL including the http:// or https:// 

• Your application username 

• The encrypted password for that application username 

The steps below will walk you through getting the necessary information and imbedding it in a 3D client 

shortcut for future use. 

1. Open a notepad document so you can paste the information strings for use in the final step.  

2. Add URL to the notepad document including the http:// or https:// with final slash and your 

username 

http://applicationURL.company/ username 

3. In a Windows Explorer window, navigate to the application 6.x folder 
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4. Locate the Call 3D.exe tool and double click to run 

 
a. Input your password 

b. Click the Encrypt button 

c. Click Copy button to copy the Encrypted text to the clipboard 

d. Paste the Encrypted password text to the notepad file 

5. Create a desktop shortcut for the Application.exe file.  

a. Right click on Application.exe and select Send to Desktop (create shortcut). This creates a 

shortcut on the desktop named Application.exe. 
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6. In the notepad file construct the information string that will be pasted into the shortcut and 

Copy. 

The syntax is: -H URL -u USERNAME -p ENCRYPTEDPASSWORD 

 

7. Right Click the Application.exe shortcut on your desktop. 

 

a. In the Target field, after the quote at the end of the path add a space and paste the 

information string from your notepad file. 

b. Click OK to save the change. 



14 3D Client Interface 

 

 

8. Double Click the desktop shortcut and the 3D Client should launch and automatically connect to 

the URL and login. 

3.6. Manage Proxy Settings 

The application has a built-in SSH Proxy component that lets you connect to the instance from a remote 

location (only if connection to the server through SSH is granted). This setup is configured through the 

Settings page. The port tunneling service performed through the 3D application remains connected 

during the duration of your session. 

Note: You can access the 2D session of a server connected through SSH only if the 3D application is 

running and a connection is established. 

Follow these steps: 
1. Add the following line to your C:\Windows\System32\drivers\etc\hosts file: 

127.0.0.1 SERVER_URL 

Save and Close the hosts file after this edit has been made. 

2. Open the Settings application. 

For new installations, the settings window is automatically opened by the application when the 

installation of the server is completed. 

To add a profile or modify an existing profile after the initial installation of the application, follow 

these steps: 

a. Locate the application folder in the Start menu. 

b. Select the Settings application within the directory. 

c. Click New to create a new profile or double click an existing profile to edit its properties. 

3. Select the SSH Proxy check box. 

4. Specify values in the SSH Proxy input fields. 

a. Server IP - Specifies the IP address of the server that you are trying to SSH into. 

b. Port - Indicates port 22 unless you specify a different value. 

c. Username - The username should be a user with access to the server such as root. 

d. Password - Enter the root password. 

Note: When the configuration is confirmed, and the user runs the 3D Client and connects 

to the application server they will use their regular username and password. Their access 

to data on the application server will be controlled by the user access rights configured by 

the administrator of the application server. 

e. Description - Entering a description is optional. 

5. Click Submit. The server tests the proxy settings. 

6. Do one of the following: 

a. If the connection is accepted, close the settings window. 

b. If connection is refused, verify that settings are correct and resubmit the proxy settings.  

Note: The session attempt will timeout if an incorrect user and password combination is 

supplied for the connection. 

3.7. Login to a Profile 

After creating an SSH Proxy connection in Settings, you can log in to that profile through the Profile 

window. 
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Follow these steps: 
1. Open the application. 

2. Select the Server Host profile. 

3. Click Verify. 

a. If all five ports pass, continue to the next step. 

b. If one of the five ports fail, go to the Settings window and verify SSH Proxy settings for the 

problematic Server Host profile. 

4. Click OK to close the verification window. 

5. Click OK to activate the selected Server Host profile. 

3.8. License Quota Control 

When logging into the 3D client the application will check the system usage versus the license quotas 

purchased by the customer. If there is an excessive number of licenses used, then the access to the 3D 

client will be blocked. Users will need to access the application in the web interface using an 

administrator account to purge excessive quota items or purchase additional licenses to apply to the 

server. Once the quota check complies, then standard login functionality is restored. 
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4. Home Page 

The client interface is designed to open separate Windows for each function performed. This feature 

lets you take advantage of multiple monitors or easily lay out the various functions on a large network 

operations center screen. Each separate window function is defined further in this document, but this 

section describes the Home Page layout and key functions. 

 

 

4.1. Navigation Tree 

Lists all locations to which the user has View access rights. There are two tabs Navigation and My Sites. 

• Navigation Tab - displays the full navigation tree 

o You can click the nodes of the tree to view summary data for each part of the location tree. 

You can also double-click floor or area names to open the floor view of the location. 

o The numbers under the node name represent the number of devices in that node and all 

child nodes that match the five alarm conditions. Red indicates Critical alarms, Yellow 

indicates Warning alarms, Blue indicates Unreachable alarms, Purple indicates Minor 

alarms and Lite Blue indicates Information. Monitored devices that have not been assigned 

a floor location are counted in the Unassigned Devices node (the last node in the tree). 

• My Sites Tab - displays the list of pinned floor plans 
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4.2. Data Charts and Dashboards 

• Shows dynamic system information and includes the main data area and several dashboards. 

The user's options for the home page layout are remembered for the next login. 

• Main Data - is the large area in the center of the screen and the display is controlled by the Main 

Data icon in the Ribbon Menu. The options include Site Data, Alarms, Dashboards, Trend Charts, 

Abstract Model and Detailed Model. Details for each option are listed below. 

• BI Dashboard - is located under the main data area and displays utilization information. It can 

be hidden by clicking the X in the upper right corner of the area. To show simply click on the BI 

Dashboard button that appears when it is hidden. 

 
• Other Dashboards - The dashboards located on the right side of the screen include Alarms, 

Estimated Yearly CO2 Emission, PUE, Cooling and Tasks (current project assignments). 

• These dashboards can be re-ordered by dragging and dropping where a green line appears. 

 
• These dashboards can be hidden by clicking on the X in the upper right corner of the 

dashboard. To show a hidden dashboard select it from the pull-down list at the top of the 

column. 
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4.3. Ribbon Menu Icons 

From left to right, these icons provide quick access to common functions from this main screen. 

• Web Interface – Opens the web interface home page in a browser window. 

• Location Studio – Opens the web interface navigation tree page related to managing and  building 

out the locations present in the navigation tree. 

• CAD Tool - Opens the floor plan builder to create a floor plan using a 3D CAD image. 

• Profile Builder – Lets you create custom device templates. 

• Services – Opens the web interface with the Maintenance Menu Group selected and displays  the 

maintenance calendar. 

• Calendar – Opens the web interface Calendar page listing all system events. 

• Port Mapping – Opens the web interface port mapping page. 

• Projects – Opens the web interface Workflow projects page. 

• Capacity Planner – Opens the web interface capacity plans page. 

• Reports – Opens the web interface data analysis reports page. 

• Main Data – Lets you select the data that will be displayed in largest and Main window of the home 

page. The options with their descriptions are listed below. The selected option is remembered and 

will be displayed when the user logs in. 

o Site Data – The Site Data panel includes the Location Power, Cooling, Space information. 

This data here is similar to the PUE Summary. 

o Alarms – Displays the active alarms for devices in the selected node of the navigation tree. 

This list is updated every 30 seconds. 

▪ Checkboxes allow user to specify which alarms are visible. 

▪ The alarm shows the Trigger which caused the alarm. 

▪ Details shows the attribute values and trigger rules which caused the alarm 

 
o Abstract Model/Detailed Model – When a floor node is selected in the navigation tree 

these options toggle between abstract and detailed floor views. 
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• Search icon – Lets you search Devices, Cables and Associated Devices. 

o Devices – Lets you search for a device. 

o Cables – Opens web interface search page. 

o Associated Devices – Lets you view and create device associations. 

• Log – Provides access to the system log file. Note that this icon is available only for users that 

belong to the administrators. 

• Current Users – Lets admin users view current users logged into the application and terminate 

sessions as needed. 

• Help – Provides information for submitting a Model Request, accesses the User Guide and links to 

the Support Portal. 

• Logout – Lets you log out and terminate the current session. 
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5. Search for a Device 

You can search for a device within the instance’s device inventory by selecting the Search icon from the 

home page ribbon menu and selecting Devices from the drop-down list. 

Two different searches can be performed: 

• Standard search - Lets you search all devices based on the specified device name. 

• Advanced search - Lets you apply various filters to search criteria. 

The advanced search gives you more control over the search criteria. You can view previous searches 

that have been completed by selecting the time clock icon in the top right corner of the Search window. 

You can also save searches and review them at any time. 

The advanced search lets you perform multiple searches. To open a new search, you select the plus icon. 

The following filters can be applied to the advanced search: 

Filter Description 

Type This value is from the Device Properties. 

Manufacturer This value is from the Device Properties. 

Model This value is from the Device Properties. 

Device Group This value is from the Device Properties. 

Asset Tag This value is from the Device Attribute named Asset Tag. 

Serial Number This value is from the Device Attribute named Serial Number. 

Software This value is the Device Application from both CMDB and the custom definition. 

Create Time This value is from the Device Attribute named Create Date. 

Status This value is the Assigned/Unassigned status of the device. 

Probe This value is the Active/Inactive status of the monitoring device. 

IP Address This value is from the Monitor tab on the device if the device is set to monitor. If the device is set to 

static, this value is populated from the IP Address attribute for the device. 

 

5.1. To perform a standard search, follow these steps: 

1. Type the device name in the Device text box. 

2. To apply a wildcard filter, use the '%' symbol before the letters. 

3. Click the Search icon to apply the filter. 

5.2. To perform an advanced search, follow these steps: 

1. Type the device name in the Device text box. To apply more filter options to the search, select the 

funnel icon in the top right corner of the Search window. 

2. Click Search to apply the filter. 

3. Click Save. The search is saved. 

A Search is performed, and qualified devices are listed in a table. The columns, starting from the left side 

of the table, are defined as follows: 
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• Device Status – Status of the device (Available, Operational, Planned, Reserved, 

Decommissioned) 

• Device Central – Device's Device Central 

• Select the icon to open that device's Device Central 

• Device Information – Device attributes 

• Select the icon to open the device information and modify its attributes. 

• Name – Device Name 

• Type – Device Type 

• Model – Device Model 

You can export the search results to an Excel file by selecting the Export button located on the bottom of 

the Search window. 

5.3. Search for a Cable 

You can search for a Cable within the instance by selecting the Search icon from the home page ribbon 

menu and selecting Cable from the drop-down list. This opens the web interface search function where 

you can search for cables, attributes, and devices. 
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6. Floor Plans 

The floor plan view in the client application is where you can access and view the majority of the device 

and site data. This section covers all the functions and features related to the floor plan view in the client 

application. 

6.1. Access Floor Plans 

To open a floor plan view in the client, go to the navigation tree on the main page of the client 

application. 

• Double-click the floor name in the navigation tree to open the floor view in a new 

window 

• If Main Data is set to Abstract Model and you see the building displayed, you can 

Double-click the floor on the building to open the floor view in a new window 

• If you double click an area on the navigation tree, just that area and its devices will be 

visible in a new window. From there you can use the Up One Level button to view the 

whole floor. 

6.2. Floor Plan Basics 

The floor plan window provides many features. They are arranged for easy access to a variety of data 

points from this single screen. 

6.2.1. Mode Menu 

Select by clicking on the drop-down Mode Menu next to the application logo on the upper left. The 

menu displays the current mode. 

Provides these options: 

• View Only Mode – Provides a read-only view option of the current floor plan. By default, any 

time a floor is opened, it is in View Only Mode. 

• Edit Mode – Lets you assign, move and delete devices on the floor plan. Only users with rights 

to Edit Mode can access this menu item and make changes to the location. This right is 

controlled at the User Group privilege level. 

• Close – Closes the floor plan window. 

6.2.2. Save and Pin Icons 

• The save icon, saves changes to the floor plan. 

• The pin icon saves the current floor plan to My Sites tab in the navigation tree. 

6.2.3. Ribbon Menu and Ribbon Bar 

Quickly access information related to the view and perform functions on devices. Each menu option is 

defined further in this section. 
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6.2.3.1. Left Side Device Tabs in Edit Mode 

View devices in the application. 

• Devices – By default lists all devices in the Current Location. Using radio buttons, you can switch 

to All and Available devices when in Edit Mode. 

o Search – Search for device name, asset tag, serial number and IP address from devices in 

the Current Location by default. When in Edit Mode it will search All or Available devices 

based on radio button selected. 

o Add Criteria – Adds search fields for Type, Manufacturer, Product Line, Model, IP 

Address, Asset Tag, Serial Number and Life Cycle attributes. The system will find the 

device where the attribute contains the text entered in the box. 

• Model – Select Model radio button to show list of models. Select Model Profile radio button to 

show list of defined Model Profiles which have been created using the Model Profile tool. (Not 

available in View Only Mode) 

o Search and Add Criteria behave as noted above against the list of models in the system. 

Note: Users can drag and drop available devices, models and model profiles to the floor. 

When you drag a model or model profile the system will prompt you to name the newly 

created device, select Group, Life Cycle and quantity. 

• Cables – List the cables for the current location and allows the list to be exported with the Export 

button. To view selected Cables, go to the Cables Show/Hide icon and toggle on Cables. 

6.2.3.2. Right Side Device Data Tabs 

Quickly access information related to the current view. 

• Layer – Displays the layer window so that you can open a layer view. Only visible when viewing 

the floor level. Works with Add Layer Map from the Layer tools in the ribbon bar. 

• Graphs – Opens the selected device's Graphs page in a web browser. 

• Attributes – Displays list of monitored datapoints, value, unit and trend charts available for the 

selected device. 

• Alarms – Displays the alarm panel, which shows the active set of alarms for the current view. 

• File Depot – If no device is select on the floor plan the File Depot tab is displayed and shows a 

list of files that you can open, based on the currently selected view. 
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6.2.3.3. Main Window 

Displays all devices currently assigned to the floor plan. Alarm indicators show the alarm state of each 

device. 

Alarm LED - Click the LED on the device and the Alarm panel shows Trigger name instead of Monitor 

Attribute. Detail is the attribute value and trigger rules. 

 

 
 

6.2.3.4. Right-Click Device Option 

Right-clicking a device to presents device-specific options. Different options are made available 

depending on which device type is selected. 

6.3. Application Tabs and Ribbon Bar 

The tabs along the top provide maximum functionality on the floor plan page while keeping the key 

features organized for ease of use. The following sections cover each of the tabs and their features in the 

ribbon bar. 
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6.3.1. Explore Tab 

The Explore tab lets you move around the screen, navigate location levels, and show or hide information 

on the screen. 

 

 

• Refresh – Updates the 3D application with the current instance. Refresh is only available when 

in View Only mode. To refresh the screen when in Edit mode, select View Only mode. 

• Reset – Resets the view of the current floor plan to the default when the view is originally 

opened. 

• Zoom In/Out – Zooms in and out on the current floor plan. 

• Other Camera Control Buttons (arrows) – Let you move, pan, rotate, and tilt the floor plan for 

better viewing. 

• Go Back/Go Forward – Return to the previous view. For example, if you go from floor plan to a 

rack view, the Go Back button returns you to the floor plan view. 

• Up One Level – Moves up the navigation tree one level from the current view. The levels are 

Device, Rack, Floor, and Building. 

• Generate Humidity/Temperature – Displays the thermographic images for associated humidity 

and temperature points in the current floor plan view and toggles the display. 

• Show/Hide Functions – check boxes to toggle viewing of various elements on the floor are now 

grouped under five icons: General, Device Status, Racks, Devices and Cables 

o General – Toggles the display of the Floor, Room Name and Walls. 

o Device Status – Toggles the display of: 

▪ Life Cycle - Displays the lifecycle of devices in the floorplan view. A legend is 

displayed which defines the colors of the devices. 

▪ Showing LEDs for Critical, Warning, Unreachable, Minor, Information and 

Normal Alarms. This control is helpful when you would prefer to see only 

Warning, Critical, and Unreachable LEDs on the floor plan. 

o Racks – Toggles the display of: 

▪ Rack Capacity - Displays LEDs based on rack capacity components: weight, 

amps,  kW, U space. 

▪ Rack Category – Displays the colors assigned to the racks based on the Rack 

Category attribute of the rack. Note, the options for Rack Category can be 

managed using the Attributes Manager tool in the web interface. 

o Devices – Toggles the display of the following device types: Chiller, Fire Suppression, 

Power Bus, Furniture and Sensor Flag. 

▪ Power Bus - Displays the power bus bar and associated tap boxes if checked. 

▪ Sensor Flag - Displays an icon where sensors are placed so users can more 

easily see sensor placement on large floorplans. 

o Cables – Toggles the display of: 

▪ Cables – Displays cables selected in the right-side Cables tab. 

▪ Cable Trays – Displays the cable tray that is above or below the racks. If cables 

are being displayed, clearing the cable trays check box hides the cables. 
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▪ Fiber Channel - Displays the fiber channel components. 

o Layer Functions 

▪ Add Layer Map – Displays an additional layer map window in the top right 

corner of the screen. Multiple layer maps can be opened simultaneously to 

view different data points in multiple windows. 

▪ Not Filtered/Filtered – Icon changes indicating if there is a filter applied or not. 

Tool allows you filter devices on the floor based on listed filter criteria. 

6.3.2. Edit Tab 

The Edit tab provides functions for organizing devices on the floor. Most of these functions are available 

only when you are in Edit Mode. You must have rights assigned to your User Group to be able to enter 

Edit Mode. 

 

• Save – Saves changes made to the floor plan. Note that changes to device locations, and so on 

are not committed to the floor plan until the Save button is clicked. 

• Remove – Removes the selected device from the floor plan. This action removes the device 

from the floor plan. It does not delete the device from the database. 

• Undo/Redo – Erases previous action items or regenerates the action items that you created. 

• Hot/Cold Containment – Lets you create a see-through container room that can be placed over 

racks. Click the icon and then drag the cursor on the floorplan to create the containment 

device. Once you have established the container, a pop up lets you define the name and the 

dimensions of the container. Once created you will see the container in the device list, and you 

can move it around. Note, you may right click and select Modify to update the properties of 

the container device. If changes are made to the dimensions, then you will need to close and 

reopen the floorplan to view the updated device dimensions. 

• Align functions – Lets you align multiple devices with each other. Select the devices by pressing 

the Ctrl key and clicking several devices. This action aligns the chosen side of the devices. The 

reference for the alignment is the chosen side of the first device selected. So the movement of 

the devices is based on the first device selected. 

• Join functions – Lets you join multiple devices side by side. This feature is very helpful for 

placing multiple racks in a row on the floor plan. The first device selected in the series of 

devices is the reference for joining devices. All devices move and attach to the first device. The 

second device selected attaches directly to the first device, the third device attaches to the 

second device, and so on. All devices automatically rotate in the join function so that all 

devices face the same direction.  

Note: When the Join function is selected, you can add space between the devices by entering 

the distance of space required. 

• Rotate functions – Lets you rotate the device based on the option selected. CW refers to 

clockwise, and CCW refers to counter-clockwise. 

• Move Device functions – Lets you move the device in the direction selected. The device moves 

relative to the direction it is facing. 
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6.3.3. Data Tab 

The Data tab provides easy access to the variety of data available in the application. 

 

 

• General Functions 

o Summary – Provides key information related to the currently selected floor plan. 

o Properties – Displays the device attributes of the currently selected device. 

o Links – Displays the list of links configured for the currently selected device. These links can 

be URLs or documents. 

o Device Central – Displays everything that is pertinent—name plate data, port mapping, 

trend charts, alarms—to a selected device. 

• Alarm Panel – Displays the Alarm Panel at the chosen level of navigation. You can view the 

alarms for the current device, floor, or building based on their selection. 

• Graphs - Opens the selected device's Graphs page in a web browser. 

• File Depot – Lets you see a list of files posted to the selected building or floor. 

• Ports – Opens the port mapping module, which lets you map network and power relationships 

between devices. You must select a device to open the port mapping module. 

6.3.4. Rack Tab 

The rack tab is enabled only when you view a rack on the screen. The menu provides key functions that 

let you build racks easily. It is available only when you select Edit Mode. 

 

 

• Shelf – Lets you easily add a shelf to the rack. Clicking a spot in the rack highlights that location 

in green. Clicking the shelf button inserts a shelf into the rack at the chosen location. 

• Blanking Panel - Lets you easily add a blanking panel to the rack. Clicking a spot in the rack 

highlights that location in green. Clicking the blanking panel button selects the size of the panel. 

A blanking panel is inserted into the rack at the chosen location. 

• Patch Panel - Lets you easily add a generic patch panel to the rack. Clicking a spot in the rack 

highlights that location in green. Clicking the patch panel button selects the size of the patch 

panel. A generic patch panel is inserted into the rack at the chosen location. 

• Cable Manager - Lets you easily add a cable manager to the rack. Clicking a spot in the rack 

highlights that location in green. Clicking the cable manager button selects the size of the cable 

manager. A generic cable manager is inserted into the rack at the chosen location. 

• Move Up/Down – Lets you easily move a selected device in the rack up or down 1 or .1 U 

positions. Each U position is divided into three, which corresponds to most rack manufacturer 

screw hole locations. 

• Move to New Rack – Lets you easily move a device from the current rack to a different rack 
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location. 

• Cut/Paste Device – Lets you cut the device form the current rack location and paste it into a 

different rack location. 

• Remove Device – Removes the selected device from the current rack. Note this action does not 

delete the device from the database. 

• Rotate Left/Right – Lets you rotate a device left or right to display correctly in the rack. This 

option is available only for devices that do not have a U size attribute defined. A good example 

of using this option is for a desktop computer sitting on the shelf in a rack. 

• Print – Lets you print a PDF of the front and rear image of a selected rack. A list of the devices 

within the rack are listed below the images. Multiple racks may be selected using the Ctrl key 

and mouse clicks. If Print is selected with multiple racks selected, then all racks and devices will 

be printed to the PDF document. 

• Hide/Show Enclosure – Lets you toggle the view of the rack with or without the enclosure. This 

action is helpful for instances when a sensor or other device is mounted to the outside of the 

rack. 

6.3.5. Services Tab 

The Services tab lets you track advanced asset management features for the devices. This tracking 

includes service event, product maintenance, warranty tracking, and more. Specific details for the 

Services module are covered later in this document. These icons let you view data configured in the 

main Services module. 

 

• Work History – Lets you view the work logs for the selected device. 

6.3.6. Help Tab 

The Help tab provides easy access to key support topics and tools. 

 

 

• Keyboard Shortcuts – Displays a list of keyboard shortcuts that can be used to navigate within 

the application. 

• Support Portal – Opens a browser window and displays the login to the CA Support portal. 

• User Guide – Opens a PDF version of the user guide. 

6.4. Left Side Tabs 

The left side tabs let you view existing devices and cables and create devices to place on the floor plan. 
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6.4.1. Devices Tab 

Allows you to search for existing devices. 

• All – Searches through all devices. 

• Available – Searches only the available devices. 

• Current Location – Searches only the devices in the currently selected location. 

• Search – The search will check if the text entered in the search field is contained in device name, 

asset tag, serial number and IP address. 

• Add Criteria – Adds search fields for Type, Manufacturer, Product Line, Model, IP Address, Asset 

Tag, Serial Number and Life Cycle attributes. The system will find the device where the attribute 

contains the text entered in the box. 

• Note: Search fields are cumulative, a device must match all of the conditions specified to appear on 

the list. 

• You can drag and drop the devices from the list directly onto the floor plan or rack to assign devices 

to the floor plan. 

• The system has 9 device modes represented as icons in the first column of the device table. 

 
o Available – The asset is available and is not currently placed on a floor plan. 

o Procurement – Refers to a device which are planned to be added in the data center. This 

device does not currently exist yet in the list available to the user to place on the floor 

plan. 

o Reserved Procurement – A procured asset that has a work order created stating the device 

is to be placed and is awaiting work order completion. The RU that the device is to occupy 

has a gold blanking panel in its place signaling the reservation. All ports associated with the 

asset are also reserved with a gold plate covering their network port or power port. 

o Reserved Available – An asset that is currently created and in the inventory list but is being 

used in a work order and to be installed in a rack. 

o Reserved Move – This is a shallow copy of the device that is selected for a move through a 

work order. This copy will remain in the RU rack position until the work order is completed. 

Once completed the shallow copy will be removed and the original device will take its 
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place. 

o Operational – The asset is currently residing on the floor plan. 

o Operational Moving – An asset that is residing in an RU that has been referred in a work 

order as action type Move. 

o Decommissioned – An asset that is being removed from the asset list. It differs from the 

state of Available because it cannot be placed back on the floor plan. 

o Plan Decommission – An Available/Operational asset that has been selected in a work order 

for decommission. 

6.4.2. Model Tab 

The Model tab is available only in Edit Mode for the floor plan. 

• Model – Searches all the models in the master model database. 

• Model Profile – Searches the list of Model Profiles which have been created using the Model Profile 

tool. 

• Search – The search will check if the text entered in the search field is contained in the model 

name. 

• Add Criteria – Adds search fields for Type, Manufacturer, Product Line and Model. The system will 

find the model where the attribute contains the text entered in the box. 

Note: Search fields are cumulative, a model must match all of the conditions specified to appear on 

the list. 

• You can drag and drop the models from the list directly onto the floor plan or rack to create devices 

and assign them to the floor plan. 

6.4.3. Cables Tab 

The Cables tab is available in both View Only Mode and Edit Mode for the floor plan. It lists the cables 

for the current location. 

• Show/Hide the various types of cables toggling the Power Cables, Network Cables, Fiber Cables 

and Storage Cables check boxes. 

• Export – Click to run the Cable Report to a pdf file. 

• To view selected Cables on the floor plan, go to Cables Show/Hide icon and toggle on Cables. 

6.5. Right Side Device Data Tabs 

The right-side tabs quickly access information related to the current view. 
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6.5.1. Layer Tab 

Displays the layer window so that you can open a layer view. Only visible when at the floor level. Works 

with Add Layer Map from the Layer tools in the ribbon bar. 

You can open a 2D window that is identical to the standard 3D floor plan view. You view a variety of data 

points and metrics overlaid on the devices in the 2D window. Selecting the Layer tab from this list 

displays the thumbnail view of the layer window. Choosing the Maximize icon in the thumbnail window 

opens the layer window to a full screen view 

6.5.2. Graphs Tab 

Opens the selected device's Graphs page in a web browser. 

6.5.3. Attributes Tab 

Displays list of monitored datapoints, value, unit and trend charts available for the selected device. 

 

 

6.5.4. Alarms Tab 

Displays the alarm panel for all devices on the floor. If a specific device is selected, only alarm data for 

that device is displayed in the alarm list. 

• List of all alarm levels across the top. 
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• Trigger for the alarm is shown. 

• Details at the bottom show attribute values and trigger rules which caused the alarm condition. 

 

6.5.5. File Depot Tab 

If no device is select on the floor plan the File Depot tab is displayed which shows a list of files that you 

can open, based on the currently selected view. 

7. Floor Plan Editing Tasks 

7.1. Enter Floor Plan Edit Mode 

To perform floor plan editing tasks, you must enter the Floor Plan Edit mode as follows: 

1. Click the drop-down Mode Menu in top left area of the window. 

2. Select Edit mode. 

7.2. Navigation Shortcut Keys 

The following navigation shortcut keys are available in Floor Plan Edit mode: 

• Zoom in – mouse wheel up 

• Zoom out – mouse wheel down 

• Move left – A, left arrow 

• Move right – D, right arrow key 

• Move backward – S, down arrow key 

• Move forward – W, up arrow key 

• Rotate clockwise – Q 

• Rotate counterclockwise – E 

• Tilt front – F 

• Tilt rear – R 

• Go back – Esc 

• Generate thermal – F2 

• Add layer map – F6 

• Save – Ctrl + S 
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• Remove device – Ctrl + D 

• Rotate clockwise 5 degrees – Ctrl + Q 

• Rotate counterclockwise 5 degrees – Ctrl + E 

• Rotate left – Ctrl + left arrow key 

• Rotate right – Ctrl + right arrow key 

• Show/hide rack frame – F3 

• Smart interface – F12 

7.3. Place Devices on the Floor 

You can place one device on the floor or multiple devices on the floor at the same time. Available devices 

are listed on the Devices tab on the left. 

To place one device on the floor, follow these steps: 

1. Find the device to place on the floor. You can search for the device by using the filter or by 

manually putting the name in the Search bar. 

2. Click the device and drag it onto the floor. When the device is on the floor, you can move it to the 

required location, as described in Move Devices. 

To place multiple devices on the floor at the same time, follow these steps: 

Note: Multiple devices to be placed on the floor at the same time must be in sequential order in the 

device list. 

1. Select the first device to be placed on the floor from the device list. 

2. Hold down the Shift key and select the last device to be placed on the floor. 

3. Click the last device that you selected and drag it onto the floor while still holding down the 

Shift key. If the device is mounted on a position which belongs to more than one area 

(embedded areas), the area listed for the location of the device will be the smallest of the 

embedded areas. 

7.4. Place Cable/Fiber Trays on the Floor 

You can place cable tray/fiber channel/power bus pieces on the floor. Available cable tray/fiber 

channel/power bus items can be located on the Cable Tray tab on the left-hand side of the 3D floor plan. 

To place a tray component on the floor, follow these steps: 

Open Floor. 

1. Change to Edit Mode. 

2. Click on the Model Tab on the Left side of the screen. 

3. Add criteria for Type filter and enter cable routing system, find the tray component to place on the 

floor. 

Note: If you want the wire baskets, just filter for basket. 

4. Click the device to select and then click and drag it onto the floor. 

Note: If component being placed on the floor is a Straight Section, you must define the length of 

the straight piece. 

5. Change to the Edit tab to see tools for editing the basket. Raise or lower the height of the tray 

above or below the floor by selecting the Set Height icon in ribbon bar in the Edit tab. 

Note: By default, the tray is placed 3.048 meters or 10 feet above the data center floor. 
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7.5. Tap Box Snap-To Power Bus Bar 

On power bus bars, tap boxes can be placed with a snap-to feature. The tap box appears to snap into a 

track along the bottom of the power bus bar. 

1. Place a straight section generic power bus bar on the floor. 

2. Place a tap box on the floor. 

3. Select the tap box (it becomes orange) and move the virtual box outline of the tap box to the 

power bus bar when the bar turns orange, the tap box snaps-to the track and you can slide 

Note: Multiple tap boxes can be placed at the same time when selected with the Control key 

along the bar to the final position. 

 
 

7.6. Connect Cable Tray Components 

You can connect multiple tray components to create a full cable tray system. To connect cable tray 

components together, follow these steps: 

1. Verify that both desired components are located on the same floor plan. 

2. Locate the anchor point tray first by selecting the anchor tray's connecting side gray box. 

The selected box turns green to indicate that it has been selected properly. 

3. Select the second component's connecting side gray box. If the second component is 

selected correctly, it connects to the anchor component. 

7.7. Move Devices 

To manipulate a device's position on the floor, click and drag the device to a location. More advanced 

device movement controls are accessible through the Edit tab at the top of the Floor Plan Edit mode 

ribbon bar. 

• Rotate functions – Let you rotate the selected device based on the option selected. CW refers 

to clockwise, and CCW refers to counter-clockwise. 

• Move Device functions – Let you move the selected device in the direction selected. Note that 

the device moves relative to the direction in which it is facing. The solid green face on the 

selected device is considered the front of the device. 

• Align functions – Let you align multiple devices with each other. You select multiple devices by 

using the Ctrl key and clicking several devices. The align functions then align the selected side 

of the devices. The reference for the alignment is the chosen side of the final device selected. 
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So all devices move based on the final device selected by the user. The green highlighted face 

of the device is the front of the device. 

• Join functions – Let you join multiple devices side by side. This function is helpful for placing 

multiple racks in a row on the floor plan. The final device selected in the series of devices is the 

reference for joining devices. All devices move and attach to the final device. The first device 

selected attaches directly to the final device, the second device attaches to the first device, 

and so on. All devices automatically rotate in the join function so that all devices face the same 

direction. 

o When the Join function is selected, you can add space between the devices by 

entering the distance of space required in the information prompt. 

7.8. Move Multiple Devices at the Same Time 

You can select multiple devices from the Devices tab in Floor Plan edit mode. 

Note: Devices must be in sequential order on the Devices tab to be placed on the floor plan simultaneously. 

To move multiple devices to the floor plan at the same time, follow these steps: 

1. Select a device on the Devices tab by its type name. Selecting its name opens up its Device Central 

page because the name itself is a hyper link. 

2. Hold down the Shift key and select the last device to be place on the floor. All the other devices to 

be placed as a group should be in between the first and last device selected. 

3. Keep holding down the Shift key, select the last device you selected from the list, and drag it to the 

floor plan. The last device selected, and all the other devices highlighted in the list are moved onto 

the floor plan. 

7.9. Delete and Save Devices 

Save and delete icons are located within the Edit tab in the Floor Plan ribbon bar. 

To save a floor plan and update the database, do one of the following: 

• Click the Save button on the ribbon bar. 

• Click the save icon in the top left corner. 

• Press CTRL + S 

To delete a device placed on the floor, select the device, and click the trash can button. If you are removing 

a device from a rack and ports are currently connected to that device, you are informed about   the 

connections. 

7.10. Clone Devices 

You can clone a device in two ways: 

• On the 2D Web Interface Devices page 

• In 3D on the floor plan 

To clone devices while on the 3D floor plan, follow these steps: 

1. Hold down the Ctrl key and select the devices to be cloned. 

Note: When you clone racks, devices in or on the rack are not cloned. When selecting the last 

device to be cloned, click and do not release the mouse button. 

2. Move the mouse to a vacant spot on the floor and release the mouse button. All the devices that 

you selected are cloned and placed on the floor. 
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8. Rack Builder 

The application contains a sophisticated rack building interface that lets you create images of racks and 

rack-mounted devices in the data center. Rack Builder also provides information about capacity and 

actual attributes of the rack. You can access the rack view by double-clicking a rack in the floor plan 

view. Note that U positions are determined based on the bottom edge of the device when it is placed in 

the rack. 

8.1. Rack Builder Components 

The Rack Builder window provides information about the rack and devices within the rack. The Assigned 

device list at the top left of the window shows a list of devices mounted in the rack. The Search window 

provides a list of devices to mount onto the rack. The Rack Summary in the bottom left of the window 

provides a total of key values for all devices mounted into the rack. 

Note that each U position consists of three sub U positions, which allow more granular mounting of 

devices onto the rack. Devices can be mounted to the front, back, left, and right positions. 

8.2. How Devices Are Assigned to a Rack 

Once the Rack Builder module has been launched, you can mount devices into the rack to create images 

of their actual racks in the data center and network closets. Two methods for mounting devices into the 

rack with this module are defined in this guide. Both methods must be performed in Edit Mode for the 

rack, not the View Only Mode. 

8.2.1. Assign Devices Already Defined in Device Manager 

If you have already defined a device in the Device Manager, search for the device and place it within the 

appropriate U space in the rack. 

Follow these steps: 

1. Select the Search menu from the top right of the Rack Builder window. 

2. Find the device that needs to be mounted to the rack by using one of these options: 

a. Type a partial device name in the progressive search box and click the Search icon to the 

right of the text box. A list of all devices that meet the criteria of the search is returned. 

b. Use the filter icon to select the Type, Manufacturer, Product Line, or Model for a list of 

target devices. You can also use the filter function to filter based on whether a device has 

been assigned to a floor plan or is still available. 

3. Select the device that needs to be assigned to the rack. 

4. Drag the device name into the correct position on the rack. 

a. An orange highlight indicates the final position for the device when the mouse button is 

released. The U position is shown if you pause mouse movement while the device is over a 

valid position on the rack. 

b. If the device being placed has a state of Available or Procurement and the device is to be 

reserved in its current RU continue to step 5. If the device being placed has a state of 

Available or Procurement and the device is to be mounted there based on availability, 

continue to step 8. If the asset is to be placed in the rack with no filter options, save the 

floor plan and the device will have its status changed to “Operational.” 
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5. With devices that have a state of Available or Procurement, right click on the device image within 

the rack and select the “Plan Installation” option to define the installation of the asset. 

6. A popup window will appear displaying filter options: Power Available, Power Ports, Network 

Ports, Storage Ports, and the last option which is not shown but automatically applied is Rack 

Weight. Select the filter options that are to be applied to the installation of the asset. Select OK to 

apply the filter. 

7. If the device meets the filter requirements the device will now change states: 

a. “Reserved” for a device with the status of “Available” and the device will get an “R” placed 

on the device image front symbolically representing the reserved state. 

b. “Reserved Procurement” for a device with a status of “Procurement” and the device will 

get an “RP” placed on the device image front symbolically representing the reserved 

procurement state. 

8. With devices that have a state of Available or Procurement, right click on the device to be formally 

mounted in the rack and select the “Move Device” option. 

9. A popup window will appear displaying filter options: Power Available, Power Ports, Network 

Ports, Storage Ports, and the last option which is not shown but automatically applied is Rack 

Weight. Select the filter options that are to be applied to the installation of the asset. Select OK to 

apply the filter. 

10. If the device meets the filter requirements, the port connections and RU will be populated and the 

device state will change to “Operational.” If the device does not meet the filter requirements the 

device will not be mounted. 

8.2.2. Creating New Devices 

Devices can be defined within the Rack Builder module. 

Follow these steps: 

1. Use the filter function in the device Search window to select the model of the new device to be 

created. 

a. Choose the appropriate options from the Type, Manufacturer, Product Line, and Model 

drop-down boxes. 

2. Click the Add icon. 

3. A popup window will appear asking of input on the devices attributes and Status. The two options 

available in the Status menu for the new device are Procurement and Available. Refer to the Device 

Status section for a definition of each state. 

a. The device is added to the device list. 

4. Drag the newly added device from the device list onto the rack. 

8.3. Reposition/Re-State Rack Devices 

All the actions below are completed through the rack view on the 3D floor plan. 

8.3.1. Manual Moving 

To reposition devices within the rack, click and drag a device to a new position in the Rack Builder module. 

The device is anchored to the nearest U position. As the device is being moved, an indicator lists the current 

U position of the device. 

Icons on the Rack ribbon menu also let you reposition a device. Click the Move Up/Move Down icons to   
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reposition the device by 1.0 or 0.1 U positions. 

8.3.2. Re-State Rack Devices 

To change the state of “Reserved” to “Operational” of a device while in the rack view, follow the steps 

below: 

1. Select a rack mounted device in the rack that has a device state of “Reserved Available”, 

“Reserved Procurement”, or “Reserved Move” and right click to select the “Set Operational 

Status.” 

a. A popup window will appear prompting the user for the following: 

b. “The device and its connections will now have a status of ‘Operational,’ do you want to 

continue? 

2. Select Yes to complete the action or select No to return to the rack view. 

8.3.3. Cancel Reservation 

To cancel the reservation of a device while in the rack view, follow the below steps: 

1. Select a rack mounted device in the rack that has a device state of “Reserved Available”, “Reserved 

Procurement”, or “Reserved Move” and right click to select the “Set Operational Status.” 

a. A popup window will appear prompting the user for the following: “Are you sure you want 

to cancel the reservation? 

2. Selecting No will close the popup. Selecting Yes will remove the reservation. The below actions will 

also be completed based on the devices current state: 

a. If the asset currently has a “Reserved Available” status, then the asset will be unmounted 

from the rack and all connections removed. The device status will be changed to 

“Available.” 

b. If the asset has a “Reserved Procurement” status, then the asset will be unmounted from 

the rack and all connections will be removed. The device status will be changed to 

“Procurement.” 

c. If the asset has a “Reserved Move” status, the shadow copy will be removed from the rack, 

all connections will be removed, and the device will be deleted. The parent asset will be 

unlocked, and its status will change from “Operational Moving” to “Operational.” 

8.3.4. Decommissioning a Device 

To decommission an asset from the rack view, follow the below steps: 

1. Select an operational rack mounted asset from the rack view and right click to select the 

“Decommission Device” option. 

a. A popup window will appear prompted the user as follows: “Are you sure you want to 

decommission the device? Yes or No? 

2. Selecting “Yes” will change the “Operational” status to “Decommission.” The device will get 

unmounted from the rack, all peripherals removed, all connections and all related assets will be 

removed. 

8.3.5. Planning a Decommission 

To plan the decommission of a rack mounted asset, follow the below steps: 

1. Select an operational rack mounted asset from the rack view and right click to select the “Plan 
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Decommission” option. 

2. The device will appear shadowed out and will have a “PD” placed on the device image symbolically 

representing that the asset is planned for decommission. 

8.3.6. Decommission a Planned Decommissioned Asset 

To decommission a planned decommissioned asset, follow the below steps: 

1. Select a device with a status of “Plan Decommissioned” in the rack and right click to select the 

“Decommission Device” option. 

a. A popup window will appear prompting the user with the following: “The device will be 

decommissioned, are you sure you want to continue?” 

2. Selecting No will return user to rack view. Selecting Yes will change the asset’s status to 

“Decommissioned,” all connections will be removed, all peripherals and related assets will be 

removed. 

8.3.7. Cancel a Decommissioning 

To cancel the decommissioning of a “Planned Decommission” asset, follow the below steps: 

1. Select a device with a status of “Plan Decommissioned” in the rack and right click to select the 

“Decommission Device” option. 

a. A popup window will appear prompting the user with the following: “Are you sure you 

want to cancel the decommissioning of the asset?” 

2. Selecting No will return the user to the previous screen. Selecting Yes will change the device’s 

status from “Plan Decommission” to “Operational.” 

8.4. Remove Devices from Racks 

To remove devices from their rack assignment, click the device in the rack and then click the Remove icon 

on the Edit menu on the ribbon toolbar at the top of the window. If a device has separate components, 

for example such as blade chassis and blade servers, all components will be removed from the Rack if the 

blade chassis is removed. 

Removing devices from the rack does not delete them from the database. Instead, it removes the device 

from the rack and floor plan view and changes the device state to Available. 

8.5. Add Non-Rackmount Devices 

In some cases, you may need to add devices to the rack, but they are not able to be mounted directly to 

the rack frame. Examples of these scenarios are the need to add a monitor, modem, zero U power strip 

and other similar devices. The rack building tool lets you mount these devices directly into the front or 

back of the rack. You can also mount zero U power strips to the side of the rack by dragging and dropping 

devices from the device list directly to the side view of the rack. 

8.6. View a Rack Summary 

The Rack Summary display provides capacity information for the rack being viewed. When you view the 

rack, the summary window is displayed on the bottom left of the main window. 

On the summary detail, you can see the Rack Capacity and Actual information related to a series of 
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categories which include Weight, Watts, Amps, and BTU. In some cases, you may see a value such as 

"2000+?" accompanied by a Yellow LED in the LED column. The question mark indicates that the 

attribute is not defined for one of the devices mounted to the rack. 

Placing the mouse over the LED lets you see which devices do not have that attribute defined so they can 

update the attributes of that device to eliminate the indicator. When the rack capacity has been 

exceeded by the Actual value, a Red LED appears in the LED column. 

Note, if users do not have rights to the Summary feature in their User Group privileges then the 

Summary icons will be disabled. 

8.7. Move Device Tool 

The rack building tool lets you easily move a device from one rack to another. When viewing a rack, 

select a device in the rack and click the Move to New Rack icon from the Rack ribbon toolbar. 

• Rack – Select the destination rack for the device being moved. The standard Search and Filter 

options are available for the list of racks. Click the destination rack in the list. 

• U Position – Depending on which rack is selected from the list, define which U position will be 

occupied by the device in the destination rack. The size of the device is matched against the 

available U positions in the rack and a list of all available positions is provided in the U Position 

drop-down. 

• Submit and Cancel – Select the Submit button to move the device or select the Cancel button 

to cancel the move function. 

8.8. Place Components into Enclosures 

The Rack Builder lets you place individual blade servers within a blade enclosure or switch cards into a 

switch chassis. This feature is commonly used with blade chassis and blade servers or with Cisco 6500 

switches and individual switch cards. 

To complete this action, follow these steps: 

1. Place a Blade Enclosure or Switch Enclosure on the Rack. 

a. Complete this step with the same device placement steps defined earlier in this section. 

2. Find the component device (blade server or switch card) in the device list. 

3. Drag and drop the component onto the enclosure/chassis device. 

a. If the component is supported by the chassis, an orange highlight shows the position 

that can be occupied by the component device. 

4. Release the mouse button. 

a. The component is assigned to the enclosure/chassis. 

8.9. Device Collision Management 

The Rack Builder has built in functionality that prevents users from adding devices that will ‘collide’ with 

one another when the device is placed into the Rack. 

Examples of Device Collision Management: 

• Mount a device in U position 20 in the front of the rack and then mount another device in U 

position 20 in the back of the rack. If these two devices are too deep and ‘collide’ with one 

another, Rack Builder will prevent users from placing the second device in that U position. 
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• Mount a device in U position 25. Try to add another device to U position 25, Rack Builder will 

prevent users from completing this action. 

9. Floor Plan Layers 

The Layer view lets you view a single data element on multiple devices simultaneously. This function 

enables you to evaluate trends in the data center. Depending on the data element being viewed, you can 

take appropriate action to fix issues if needed. This floor plan layer function is located on the right side of 

the 3D floor plan window. If the layer window is not visible, click the button on the ribbon bar to add a 

layer window. 

Clicking the Add Layer Map button multiple times adds more than one layer window for viewing. On the 

layer box, click the maximize option to expand layer. 

9.1. Layer Options 

Selecting a layer from the floor plan layers menu on the right displays that characteristic or value of the 

device in the main view of the floor. Typically, a legend appears on the top right of the screen to define 

the color codes used for that particular view. The following is a brief description of the available layers 

that you can select: 

9.1.1. UI Layers 

• Alarm – This default view of the floor plan lets you see the alarm LEDs on each device if that device 

is in an alarm state. The LED displayed corresponds to the exact state of the device as of the most 

recent polling event. 

• Device Names – Displays the device name. If no device is assigned, then this field is blank. 

• Device Type – Displays the device type. If it is an object and not a device, the field is shaded gray 

and does not display any name. 

9.1.2. Rack Layers 

Each of these values are displayed only if the device is a rack. If the device is not a rack, they are shaded 

gray and do not display any data. 

• Ports – Fiber Available – Displays the total number of unoccupied fiber ports on that rack. 

• Ports - Fiber Reserved – Displays the total number of reserved fiber ports on that rack. 

• Ports – Fiber Total – Displays the total number of fiber ports that are in that rack. A fiber port may 

be located in another rack and have its fiber ports reserved/mapped for another rack. In that 

instance, the ports would be visible on the reserved rack, not the rack it is placed in. Refer to Port 

Reservation for more information. 

• Ports - Fiber Used – Displays the total number of occupied fiber ports on that rack. 

• Ports – Network Available – Displays the total number of unoccupied network ports on that rack. 

• Ports – Network Reserved – Displays the total number of reserved network ports on that rack. 

• Ports – Network Total – Displays the total number of network ports that are in that rack. A network 

port may be located in another rack and have its network ports reserved/mapped for another rack. 

In that instance, the ports would be visible on the reserved rack, not the rack it is placed in. Refer to 

Port Reservation for more information. 

• Ports – Network Used – Displays the total number of occupied network ports on that rack. 
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• Ports – Power Available – Displays the total number of unoccupied power ports on that rack. 

• Ports - Power Reserved – Displays the total number of reserved power ports on that rack. 

• Ports - Power Total – Displays the total number of power ports in that rack. A power port may be 

located in another rack and have its power ports reserved/mapped for another rack. In that 

instance, the ports would be visible on the reserved rack. Refer to Port Reservation for more 

information. 

• Ports – Power Used – Displays the total number of occupied power ports on that rack. 

• Rack Capacity – Displays the capacity of the rack in U. 

• RU Front Max Contiguous – Displays the largest continuous amount of rack space available in the 

front of the rack. This value is helpful in understanding where a 10U blade chassis can be deployed. 

• RU Front Reserved – Displays the amount of reserved rack space and is displayed in U. The value 

will have the format of Front Space Reserved/Capacity (for example, 14/42). 

• RU Front Used – Raw number of U positions used in the front of the rack. 

• RU Front Utilization – Displays the amount of front rack space used and is displayed in U. The value 

has the format of Front Space Used/Rear Capacity (for example, 14/42). Floor spaces are color-

coded to show the % of rack space currently utilized. The legend defines the colors as compared to 

percentages. 

• RU Rear Max Contiguous – Displays the largest continuous amount of rack space available in the 

rear of the rack. This value is helpful in understanding where a 10U blade chassis can be deployed. 

• RU Rear Reserved – Displays the amount of rear rack space reserved. The value is displayed in U 

and has the format of Rear Reserved Space/Capacity (for example 14/42). 

• RU Rear Used – Raw number of U positions used in the rear of the rack. 

• RU Rear Utilization – Displays the amount of rear rack space used. The value is displayed in U and 

has the format of Rear Space Used/Rear Capacity (for example, 14/42). Floor spaces are color-

coded to show the % of rack space currently utilized. The legend defines the colors as compared to 

percentages. 

9.1.3. Environment Layers 

Each of these options has color-coded results that tie back to the colors defined in the legend on the top 

right of the floor plan window. 

• Humidity – Displays the humidity value for that device. This value maps to the monitor attribute 

located in 2D under the Device tab. Refer to Web Administration User Guide for more 

information. 

• Temperature – Displays the temperature value for that device. This value maps to the monitor 

attribute located in 2D under the Device tab. Refer to Web Administration User Guide for more 

information. 

• Temperature Discharge and Temperature Return – Display the values assigned to the "AC – 

Discharge Temp" and "AC – Return Temp" monitor attributes. 

• Thermal Lower, Middle and Upper – Provide a thermal graphic on the floor plan, based on the 

values assigned to devices in the EnvTemp monitor attribute setting. If these monitor attributes 

have values mapped to them, the thermal layers display those temperatures in a thermal graphic 

by using the thermal algorithm in the product. When you view thermal layers, the value assigned 

to the Layer – Temperature monitor attribute is displayed as the value on the device. 

9.1.4. Energy Layers 
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• A/B Side Current – Available for Rack devices only. This shows the Current Actual values for the 

racks. 

• A/B Side L1 Current – Available for Rack devices only. Shows the Phase 1 Current data for the 

racks. 

• A/B Side L2 Current – Available for Rack devices only. Shows the Phase 2 Current data for the 

racks. 

• A/B Side L3 Current – Available for Rack devices only. Shows the Phase 3 Current data for the 

racks. 

• Current Actual (A) –Displays the Amps collected for that device. If the device is set to monitor, 

this value is real time data. If it is set to Static, this value is pulled from the device attributes. 

• Current Derated (A) –– This value is mapped to the device attribute Current Derated. 

• Current Utilization (A) –– This value is math-based on the other Amps layers as follows: Current 

Actual/Current Derated * 100. 

• Power Actual (kW) – Displays the Kilowatts collected for that device. If the device is set to 

monitor, this value is real-time data. If it is set to Static, this value is pulled from the device 

attributes. 

• Power Derated (kW) – This value is mapped to the device attribute Power Derated and is a static 

data point. 

• Power Utilization – This value is math-based on the other kW layers as follows: kW Actual/Rack 

Kilowatts Capacity * 100. 

9.2. Layer Filters 

Layer Filters let you limit the viewable devices by constraining their display with one or multiple criteria. 

This tool can help you understand how certain components of the data center are operating at a given 

time. 

The Layer Filter options let you filter devices by using two different methods: By Layer or By Device. 

These options can work in with each other to provide maximum viewing flexibility. 

9.2.1. Filter By Layer 

Filtering by Layer lets you filter device views based on a series of data filters. The following is an example 

of how the Layer Filter tool lets you find racks on the floor plan that meets certain criteria: 

• Rack has under 16U contiguous space available 

• Power Ports remaining is greater than 80 

• Rack Temperature is less than 82 degrees 

Each required criterion is added to the filter list and the Filter button finds devices that match the defined 

criteria. Selecting a single criterion item and clicking Delete removes the filter item from the list. Clicking 

the Clear button clears all filter settings. You must click the Filter button after changes to the filter list to 

update the device view on the main page. 

Add these filter criteria to the filter tool as follows: 

• Select the Add button to define the first criterion for the Search. 

• Select the Layer Type. If the layer is a value, select the Value option. If the value is Yes or No, 

select the Enumerate option. 

• Select a layer to view (for example, the Temperature Layer). 

• Select the operator for the value being compared. 
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• Enter the Value used for the comparison in the filter. 

• Click the Add button. Criteria are added to the search window. 

• If additional criteria need to be added, repeat these steps as required. 

• Click the Filter button. Only devices that match the criteria are displayed. 

When you click the Execute button, the resulting image displays only the devices that meet the filter 

criteria. 
 

9.2.2. Filter By Device 

Filtering by Device lets you view only data for certain Device Type, Manufacturer, Product Lines, Models, 

or Device Groups. 

To use this function, select the required filter criteria from the drop-down boxes provided and click the 

Filter button. 

Note that the By Layer and By Device filter options work in with each other. This feature provides 

maximum flexibility in viewing the device layers based on data or on device characteristics. 

9.3. Layer History 

A unique feature of the application is how you can view the history of certain layer values over a user- 

specified time. This feature provides a different graphical view of historical data related to 

environmental and power conditions in your facility. 

The layer history has these components and settings available to control the playback of the historical 

data for the chosen layer view: 

• Start Time – Lets you specify the starting date and time to begin the replay of data. 

• End Time – Lets you specify the ending date and time to stop the replay of data. 

• Speed – Lets you specify the number of seconds to pause on each frame of the view. 

• Play, Stop, Reset – Lets you control the playback of the data. 

• Timeline – Provides information on progression from start to end time and the currently 

viewed Date/Time. 

10. Alarm System 

10.1. Alarms Overview 

The alarm engine generates alarms when actual values collected in the monitoring process cross into 

user-defined threshold ranges. The result of this threshold-to-data relationship is that the device is 

tagged with an Alarm LED on the floor plan, and the alarm panels are updated with that information. 

A device can have one of the following alarm states: 

• Alarm State Acknowledged 

• Normal (green) 

• Critical (red) 

• Warning (yellow) 

• Unreachable (blue) 

• Minor (lavender) 
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• Information (light blue) 

• Exceptions (aqua) 

Each time a device is polled, it returns one of these six states to the system (Acknowledged state occurs 

only when you acknowledge an alarm). The Alarm Panel provides an easy way to see the overall state of 

monitored devices and their data elements and polling history. 

Note: A device can maintain two other alarm states related to the Critical and Warning levels. When setting 

a threshold for a data element, you can configure a Min Time On or Min Time Off setting. When a device 

reaches a warning or critical value but is still within the Min Time On/Off time settings, the LED displays 

half green/half red or half green/half yellow if the threshold is set to Critical or Warning, respectively. 

The Critical and Warning alarm will pop up in the bottom-right corner of 3D client. There is a Config to 

disable / enable the alarm popup window in the System Settings. The critical and Warning alert sound are 

same and used the default one. There is a config to disable / enable the alarm sound. 

10.2. Active Alarm Panel 

You access the Active Alarm Panel on the 3D home page application. 

In the Floor Plan Editor mode, a ribbon bar on the right has an Alarms tab. By clicking the tab, a panel opens 

and shows all Alarm panels that are not in a Normal state by default. 

10.2.1. Filter Options 

The alarm panel lets you apply a series of filters to the list to limit the items provided in the table. 

• Locations – Select either the Current Floor or System radio buttons to view devices only on the 

currently viewed floor or to view devices managed throughout the application in all locations. 

• Device Name – Enter a partial device name in the field provided to return only a list of items that 

match the partial device name search. The partial name must be the first characters of the device 

name. Device Name search is not case-sensitive. 

• Alarm Level – Check each alarm status to be viewed in the list while executing a search. Devices 

with a status that match the selected check boxes are displayed. Note that the Normal option 

shows all devices currently being monitored that are not in an alarm state. 

• Last Time – Show the last time that that event for the device occurred. 

Clicking the Submit button executes the search command based on the user-defined filter options. 

10.2.2. Acknowledge Alarms 

System operators can acknowledge an alarm. This action indicates to other users that the alarm has 

been received and is being addressed. 

Follow these steps: 

1. Open the Active Alarm Panel and click the check box in the Ack column for all alarms to be 

changed to an Acknowledged status. 

a. The Select All check box at the top of the list lets you automatically select all alarms 

in the list. 

2. Click the Submit button. 

a. An embedded A is shown in the LED on the device. 
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Note: After an alarm has been acknowledged, it will continue to have an 

Acknowledged status until it returns to Normal status. Then, any subsequent alarms 

for the device will maintain the standard Warning, Critical, or Unreachable status. 

b. Acknowledging an alarm also has an impact on the Notification engine. When an 

alarm is acknowledged, notification escalations for that device or data element end 

until it returns to Normal and enters an alarm state once again. 

10.2.3. Clear Alarms 

System operators can clear an alarm from the list by selecting the check box in the Clear column for all 

alarms that you want to remove from the list. 

Clearing the alarm sets the status of that device/data element to normal. On the next polling interval, 

the device will reappear in the alarm list if an alarm condition is generated again. 

10.2.4. View Detailed Alarm Information 

When you highlight the data element under a device, detailed information related to the alarm and 

alarm condition are displayed in the Detailed Alarm Information section at the bottom of the list. 

Follow these steps: 

1. Click the Expand button next to a device. 

2. Select the alarm. 

a. The bottom of the Alarm Panel window provides a detailed description of how the alarm 

went into that state. 

10.3. View Alarm History 

A detailed alarm history of each data element for all devices is maintained in the alarm panel.  

When viewing the data elements of the device in the alarm panel, do the following: 

1. Double-click one of the listed data elements. 

a. The alarm panel shows a list of all alarm states that data element has been in 

during polling activity. An entry included in this list shows if an alarm has been 

Cleared or Acknowledged by a user. 

2. Access the Alarm History by double-clicking the device's Monitor Attribute that is in 

the alarm state. A separate window displays the data history. 

a. Level – Indicates the alarm state of that device during the period of time 

defined in the record. If the alarm was cleared or acknowledged, the username 

is included in parentheses. 

b. Alarm Count – Indicates the number of alarm events that occurred for that 

device-data element at that alarm level. 

c. Start/End Time – Indicates the time of the initial polling event that resulted in 

that alarm condition and the last time that condition was returned in the 

monitoring engine before a new state was reached. 

10.4. Export Data to an Excel Spreadsheet 
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Each alarm panel page has an Export button that lets you export the data to a spreadsheet. 

To export a list of items to an Excel spreadsheet, click the Export button. 

11. Device Central 

Device Central is an all-in-one window that collects all information on a device. All the attributes within 

Device Central are specific to the device that was selected. 

There are several ways to access Device Central: 

• In the floor plan window, select the Data tab and select the Device Central icon 

• Select a device on the floor, right click and select Device Central 

• Use the search tool and in the results table select the Device Central icon 

11.1. Summary Tab 

The summary tab displays all basic information specific to the Device Central device that was selected. 

All the information is self-populated from the Device Attributes in the Web Administration Interface. 

Links to documents or websites are placed in the Links section, located to the right of the basic 

information. These links are self-populated from the Device Information – Links tab in the Web 

Administration Interface. Peripheral devices can be added or removed from the peripherals section. 

Devices can be linked together logically using the Associated Devices section. 

When viewing Device Central for a PDU Floor mount device, a link will automatically be displayed for the 

PDU Panel Schedule. This link will open a report which summarizes the PDU branch circuit monitoring 

configurations. 

• Graphs Link - Opens the selected device's Graphs page in a web browser. 

• Calendar Link - Opens the selected device's Calendar page in a browser window. 

11.2. Alarms 

The Alarm tab in Device Central shows the status of all the alarms mapped to the device. By default, only 

the alarms that are in warning, critical, unreachable, minor or information are shown. 

To find only alarms in a certain state, click the appropriate state from the filter tab at the top of the 

window. The filter is not dynamic. The Search button must be selected to apply the filter. 

11.2.1. Acknowledging Alarm Condition 

The following check boxes are located below the Alarm filter: 

• Clear All Alarm (on the left) 

• Acknowledge All (on the right) 

Selecting one or both box applies that action to every alarm that has that option. For example, selecting 

the Clear All Alarm box clears all alarms in a warning, critical, minor or information state. Selecting the 

Acknowledge All box acknowledges all alarms in a state other than normal and updates the status. You 

must click the Submit button at the bottom of the window for the decision to take effect. 

To acknowledge an individual alarm, go to the desired alarm and select the check the box under the Ack 

column. 
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To clear the alarm, select the Clear check box in the Clear column. You must click the Submit button to 

update and save the status. 

Double-clicking an individual alarm opens an alarm history window. 

11.2.2. Export Alarms 

To generate an Excel file for alarms, click the Export button at the bottom of the page. 

The Excel file reads the same information shown on Device Central Alarm tab. It does not print the 

history of the alarm but does print the current state of the alarms for that device. 

11.3. Services 

The Services link in Device Central opens the web interface’s device central page for the selected device 

with the Services function tile selected. 

11.4. Warranty 

The Warranty link in Device Central opens the web interface’s device central page for the selected 

device with the Warranty function tile selected. 

11.5. Port Mapping 

When you access Port Mapping through Device Central the web interface Device Central page will be 

shown with the Ports Function Tile selected for the selected device. The device's ports list will be 

presented along with a Connections tab where current connections are listed. 

See Port Mapping section in web interface guide for more information. 

11.6. Root Cause Analysis Link 

The Root Cause Analysis link opens the web interface root cause analysis page for the selected device. 

See the Root Cause Function Tile section of the Web Interface User Guide for details. 

11.7. Impact Analysis 

The Impact Analysis link opens the web interface impact analysis page for the selected device. See the 

Impact Function Tile section of the Web Interface User Guide for details. 

11.8. Associated Devices 

Users have the option of logically linking devices using the Associated Devices table in device central on 

the Summary Tab. Devices which are linked in this way will move and decommission together. 
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11.8.1. Creating a Device Association List 

1. Click the New button on the upper right side of the Associated Devices table. 

2. In the devices window you can filter by Device name, Type, Manufacturer, Product Line, Model, 

Group, Status, and List Items. 

3. After locating the devices, you would like to add to the list click on the device and click add, you can 

also hold CTRL to select multiple or shift. 

4. On the right side of the window, you can provide a name for the device list. 

5. When done selecting devices for the list click Submit. 

6. Selected devices on the list can be removed using the Delete button. 

12. Device Action Keys 

When viewing devices in the floor plan views, Right clicking a device lets you perform actions, 

depending on the type of device. These actions range from being able to access Device Central to 

displaying a 3D view of the Impact Analysis that device has on other devices. 

The following items appear when you right-click a device: 

• Rack device 

o Port Manager 

o Device Central 

o Impact Analysis 

o Network Path 

o Power Path 

• Non-Rack device 

o Device Central 

o Impact Analysis 

o Network Path 

o Power Path 

12.1. Apply the Impact Analysis Filter 

The Impact Analysis option applies a filter to all the devices on the floor and shows all the devices that 

are impacted by the selected device. If the affected devices are in a rack, the rack is hidden and only the 

device is shown. 
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Follow these steps: 

1. Right-click the device. 

2. Select Impact Analysis from the drop-down list. 

a. The impacted devices, including the device that was right clicked, are shown. 

b. To return to an unfiltered 3D floor plan view, select the Layer Filter check box in the top 

ribbon bar under the Explore tab. 

12.2. Apply the Power Path Filter 

The Power Path option applies a filter to all the devices on the floor and shows all the devices connected 

by a power connection to the selected device, both upstream and downstream. 

Follow these steps: 

1. Right-click a device. 

2. Select Power Path from the drop-down list. 

a. The filtered devices, including the device that was right clicked, are shown. If the device 

connected by a power connection is in a rack, the rack is hidden and the only the device is 

shown. 

12.3. Apply the Network Path Filter 

The Network Path option applies a filter to all the devices on the floor and shows all the devices 

connected by a network connection to the selected device, both upstream and downstream. 

Follow these steps: 

1. Right-click a device. 

2. Select Network Path from the drop-down list. 

a. The filtered devices, including the device that was right clicked, are shown. If the device 

connected by a power connection is in a rack, the rack is hidden and only the device is 

shown. 

13. CAD Tool 

CAD Tool lets you upload a 3D CAD file (.dwfx) to create a floor plan. 

1. Click on the CAD Tool icon on the 3D Ribbon Menu. 

2. In the CAD Tool window select the floor node in the navigation tree where the floor plan file is to be 

uploaded. 

Note: The floor node must be created in the web interface. 

3. Click on the Upload Image icon and navigate to the 3D CAD file (.dwfx) and Click Open. 

4. Rotate the file as needed and Click OK. 

5. Click OK to accept the Floor Setting. The application finds all the intersecting lines and places 

anchors at these point and then places solid walls between these anchor points. It then creates the 

floor area around the external anchor points. 

6. Edit the floor as needed by adding anchor points, walls, areas, etc. 

7. When complete Click Publish to publish the floor plan to the navigation tree. 

8. Refresh the navigation tree to see the floor. 
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14. Profile Builder 

Profile builder lets you create custom models and create multiple instances of that model in the 3D floor 

plan. Models can be multiple devices, which means that you can create creating complex rack designs 

that are used multiple times. The Profile Builder window provides the Explore, Edit, and Rack tabs to help 

you create custom models. 

14.1. Create New Model Profile 

To create a new model profile, follow these steps: 

1. Click and drag the device(s) from the device list and onto the profile canvas. 

2. Create the model profile by using the standard floor plan controls. 

3. Verify that all attributes of the new model profile are set and click the Save icon. 

4. Specify a name for the model and select OK. 

14.2. Delete a Model Profile 

To delete a model profile, follow these steps: 

1. Select the Model Profile tab on the left side of the Model Profile window. 

2. Select the red X next to the model to be deleted. 

15. Services Module 

The Services and Warranty functions are now only available in the web interface. Please refer to the 

Web Interface User Guide for information. 

16. Capacity Planner 

Selecting the Capacity Planner icon in the 3D Home Page ribbon bar opens the Capacity Plans page in 

the web interface. See the Capacity Plans Menu Item section of the Web Interface Guide for details. 

17. File Depot 

The File Depot is located on the Floor Plan page and is used to upload files to the floor plans. These files 

are available to all users to download and view. The File Depot is typically used for these types of files: 

engineering plans, user guides, escalation procedures, contact information or other similar types of 

documentation. 

The following are two separate repositories available for users to upload documents: 

• Public – Files loaded to the Public section can be viewed on all floor plans. 

• Private – Files loaded to the Private section are viewed only on the currently viewed floor plan. 

17.1. Create Folders 

You must be in Edit Mode to be able to modify the File Depot. 

Follow these steps: 
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1. Click the Create link to create Folders in the File navigation tree while viewing the File Depot. 

a. The folder is added under the currently selected node in the tree, and you are prompted 

for a Folder Name. 

2. Specify a name for the folder and click the Submit button. 

17.2. Upload Files 

To upload one or multiple files to the selected folder, follow these steps: 

1. Select a file folder in the navigation tree. 

a. The Upload link is available. 

2. Click the Upload button. The Upload File dialog appears and prompts you for a File Name. 

3. Click the Browse button. 

a. The Windows File Explorer window opens. 

4. Navigate to the location of the file to be uploaded. 

5. Select the file and click The Submit button. 

a. The selected file is uploaded to the File Depot. 

b. If a file has the same name as an existing file, there will be an Error Message indicating it 

already exists. 

17.3. Rename Folders and Files 

After folders are created or files are uploaded, they can be renamed. 

Follow these steps: 

1. Select the folder or file that needs to be renamed and select the Rename link in the File Depot. 

a. The Rename dialog appears. 

2. Provide a new name for the folder or file and click the Submit button. 

Note: You must include the file extension in the new name. 

17.4. Delete Folders and Files 

To delete folders and files that have been added to the File Depot, select the folder or file and click the 

Delete link. You are prompted to confirm the deletion. 

If a Folder is deleted, all files contained in that folder are also removed from the system. 

18. Uninstall 

To uninstall the client from Windows, navigate to Start --> Apps & Features. Locate and Select the 

application and Click Uninstall. 
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